


Do not use this product in any way that interferes with safe and attentive operation of a
vehicle.  The driver must remain alert at all times to actual road conditions and obey all
posted signs and traffic regulations.   

Always keep your hands on the steering wheel and eyes on the road when driving!
While driving, either ask a passenger to operate CoPilot  or pull over to the side of the
road when operating CoPilot on your laptop.

Your CoPilot Live | Laptop 7 package includes the following:

 Install/Data Disc

 Printed Quick Start Guide

GPS receiver and suction cup for securing receiver to windshield 
(not in software-only packages)
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Important Note, Please Read:

1.  Check the package contents
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2.  (Optional) Uninstall previous version of CoPilot

To uninstall the CoPilot software:
(1)  Exit out of any programs that are running.
(2)  On your desktop, double-click on My Computer.
(3)  Double-click on Control Panel.
(4)  Double-click on Add/Remove Programs.
(5)  Scroll down the list of applications until you see the CoPilot application. Click

on it to highlight it, then click Add/Remove.  You will be asked “Are you sure
you want to completely remove the selected application and all of its
components?”, click Yes.  This will start the uninstall process.  If prompted to
remove all shared files select No to All.

(6)  Click on Finish.  Then restart your computer.

To uninstall the Watson speech software (older versions):
(1)  Follow steps 1-4 above.
(2)  Scroll down the list of applications until you see Watson V 2.1 Gold

Redistributed.  Click on it to highlight it, then click Add/Remove.  You will be
asked “Are you sure you want to completely remove the selected application and
all of its components?”, click Yes.  This will start the uninstall process.  If
prompted to remove all shared files select No to All.

(3)  When this is finished, click on Finish.  Then restart your computer.

To uninstall data from older versions of CoPilot:
(This process is only required for versions older than CoPilot 2002.)

(1)  Follow steps 1-4 above.
(2)  Scroll down the list of applications until you see CoPilot 2001 Data CD or Data

CD setup for CoPilot 2000.  Click on it to highlight it, then click the
Add/Remove button.  When asked “Are you sure you want to completely remove
the selected application and all of its components?”, click Yes.  This will start the
uninstall process.  If prompted to remove all shared files select No to All.

(3)  When this process is finished, click on Finish.  Then restart your computer.
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3.  Install CoPilot

4.  Activate the software

Installation Steps:
(1)  Insert the CoPilot Install Disc into your CD-ROM drive.  After clicking Yes to

accept the License Agreement, enter your Product Key Code when prompted (you
can find it on the front cover of this Quick Start).  Click Next. 
Keep following the instructions in the Installation Wizard, clicking Next to go from
one screen to the next.

(2) Install Data: You will be given the choice to install map data to your hard drive.
You can install the entire map database, which can require up to 1 GB of space
depending on which region you’re installing.  This is the recommended option.  If
space is unavailable, you can run the program by inserting the Data Disc into your
CD-ROM drive after you open the CoPilot application. NOTE: Once you install a
region it cannot be changed.

(3)  Activate the Software: See Activate the Software below.

(4) When the installation is complete, double-click the CoPilot Live | Laptop 7 icon
that was placed on your desktop to start CoPilot.  If your GPS receiver is attached,
you will be asked to enter a nearby city (see Steps 5 and 6).

At the end of the installation process you will be asked to activate the software.  CoPilot
must be activated before you can use it.  If you don’t activate during installation, you
will be asked to do this when you open the application.  Follow the steps outlined on the
next page to activate.



For Automatic Activation:

If your laptop is connected to the internet, you can automatically activate CoPilot at the
end of the installation process as follows:

1. At the end of the software installation, an activation screen will appear.  Follow
the on-screen instructions and click Next.

2.  In the next screen, enter your e-mail address and click Next.  You will see the
message “License activated successfully” when the process is finished.  Click
Next to begin using CoPilot.

To Activate Manually:
1. Check Activate Manually in Step 1 above and click Next. 
2. The next screen is the Activation Code screen, where you’ll see your Product Key

and License ID.  You’ll need this information to manually activate CoPilot as
follows:

a)  If your laptop is connected to the internet you can click the link to ALK’s
activation web page.

i)   On the ALK activation page, enter your Product Key, License ID, and 
e-mail address, then click Submit.  Your Activation Code will appear on-
screen and an e-mail containing your Activation Code will be sent to you.

ii)  Enter your Activation Code in the blank field in the Activation Code screen
and click Activate.

b)  If your laptop isn’t connected to the internet you can visit ALK’s activation
web page (http://activate.alk.com) on another personal computer.  Follow
steps i) and ii) above.

c)  If you do not have internet access you can call, fax, or e-mail ALK.  Technical
support is available to registered users during standard business hours.   

For ALK Technologies contact information, see Contact Information and
Additional Help, p. 9.  
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WARNING: Never leave your GPS receiver in a closed vehicle that exceeds 140o F.  It
could be damaged by the heat.

Illustrated instructions for setting up a USB receiver and a Serial receiver are shown
below.  The GPS unit should be placed far forward on your vehicle’s dashboard to
maximize the satellite reception area.

The first time you use your GPS receiver, it may take up to 15 minutes to get a satellite
fix.  After you use it once, the receiver should initialize within a few minutes.  The GPS
receiver works like a radio antenna, so place it at least two feet away from possible
sources of interference (for instance, a cellular phone antenna).

SERIAL Connection:
When connecting to a laptop through a serial port the receiver is powered through the
laptop’s battery.  Plug the PS/2 port connector on your GPS unit into the PS/2 port of
your laptop.  Do not plug the serial port connector into your laptop until after Windows
has finished booting up.  

TIP: To see the serial ports available on your PC, open the Control Panel, select
System, click on the Device Manager tab, then click on the plus sign next to Ports in
the list of devices.  The Settings box displays the hardware settings used by the COM
port.  The setting for your COM port should be 4800,8,N,1.
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5.  In-vehicle hardware setup

GPS
Receiver

Serial Port
Connector

PS/2
Connector



USB Connection:
If you are using a USB connection you will have one wire which attaches the GPS
receiver to the laptop through its USB port.  Plug the receiver into the laptop after
Windows is finished booting up.
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6.  Enter a nearby city

When you first launch CoPilot with the GPS receiver attached, you will be prompted to
enter your nearest city to help speed up initial satellite acquisition.  Type your nearest
city/state or city/country (e.g. “princeton, nj” or “paris, fr” or “melbourne, vic”), then
hit the Enter key on your keyboard.

CoPilot will confirm your nearest city.  Click Apply to continue.

USB Port
Connector

GPS
Receiver



NOTE: There is no need to enter a starting point.  CoPilot uses GPS positioning to
determine your location automatically.

In the Guidance screen, click Destination to enter an address.  Then click Address to
enter a city name and state/country abbreviation or a postal code, and a street address. 

Enter a city name and state or country abbreviation separated by a comma and space 
(e.g. “princeton, nj” or “paris, fr” or “sydney, nsw”), then hit the Enter key on your
keyboard .  For more specific guidance you can also type a street address, with or
without a building number (e.g. 158 nassau st), and hit the Enter key.

TIP: Usually you will need to spell out words like "Saint", "Mount", "Fort", etc.  Place
names generally need to be spelled out: "John F. Kennedy International Airport"
instead of "JFK Airport".  If you have problems finding an address, try different ways of
spelling words and/or place names.
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7.  Enter a destination



In subsequent uses, your last destination will appear and you will be prompted to
confirm or change your destination.  You can choose to Go! to that destination, Add,
Edit stops, or Clear all stops and start over.

TIP: You must disable your screen saver
before using CoPilot.  In the Start menu go 
to Settings, Control Panel, double-click on
the Display icon, select the Screen Saver
tab, and select (None).

Start driving! As your GPS unit receives signals, arrows will appear on the map
beginning at your start place and tracking you as you drive.  CoPilot will automatically
provide on-screen directions and verbal prompts when your next turn is coming up.  If
you go off route, CoPilot's “Dynamic Directions” will reroute you to the next stop from
your current position.  In the Driver Safety screen, the map will be minimized when
you drive over 10 m.p.h.
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8.  Start driving

Contact Information and Additional Help

For more detailed instructions, see the .pdf format User’s Guide and the .txt Readme that
came with the product or CoPilot’s extensive system of Help Files (in Planning Mode, go
to Help menu > Help Contents and Search).  Technical support is available to registered
users during standard business hours — Monday-Friday, 9:00am-5:00pm. 

North America - Web: www.alk.com, E-mail: cpsupport@alk.com, Fax: 609-252-8166,
Phone: 888-872-8768

Europe - Web: www.alk.eu.com, E-mail: ukcustservice@alk.eu.com, 
Regular Mail: Suite 595, 2 Old Brompton Road, London SW7 3DQ, UK

Australia - (Travroute Australia Pty. Ltd.) Web: www.travroute.com.au, 
E-mail: support@travroute.com.au, Phone: 03-9855-1652
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What’s New in CoPilot® Live | Laptop 7?
CoPilot Live | Laptop 7 is ALK Technologies’ latest version of our CoPilot® software that
provides GPS in-vehicle navigation and route guidance from your laptop PC.  New features 
and enhancements we think you’ll like include:

--  Redesigned User Interface: The user interface has been overhauled to promote easier
access to CoPilot’s main features and to make getting directions even safer than it
already was.

-- New Text-to-Speech and Automatic Speech Recognition Engine: A new TTS and
voice recognition engine has been implemented to ensure compatibility with the latest
hardware and to enhance user experience with the latest in voice rechnology.

-- Live Messaging:  Maintain two-way communication with a driver who’s using CoPilot
Live with text messages, tracking information and itinerary updates.  Live features can
be used from any computer that can access the internet.

--  Customizable Navigation Display: Now you can customize your navigation screen 
in Guidance Mode to display the current road, nearest city, upcoming crossroad, vehicle
speed, current time, elevation, and latitude/longitude.  ETA, distance to next stop, and
next stop address are always displayed and continually updated as you drive.  

-- Worldwide Data Regions: CoPilot street-level map data is now available for multiple
regions on the same computer.  Available regions with street-level detail include:

-  United States (with highways for Canada and Mexico)
-  Canada
-  Australia
-  Europe (includes United Kingdom, Germany, France, Italy, Belgium, 

Netherlands, Luxemburg, Austria, Switzerland, Denmark, Sweden, 
Finland, Norway, Spain, and Portugal)

-- Avoid/Favors: Now you can avoid or favor roads so that you’re driving the routes you
want to drive.

-- Waypoints: Use waypoints to customize your trip without affecting the calculations for
ETA and distance to your final destination.
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-- Fuel Cost Calculator:  Receive an estimate on your total fuel cost for every trip in
Planning Mode.

-- POI Notification: If you choose, CoPilot will now inform you of every POI along 
your route as you approach it.  These alerts will be included in CoPilot’s spoken 
directions and will appear on your screen too.  You can select which categories of POI
you would like to know about, and how close you would like to be to each POI when 
you hear the alert.

System Requirements
--  Microsoft® Windows® 98, 2000, ME®, XP, or

Windows NT® (4.0 or higher).
--  266 MHz Pentium® II processor or equivalent.
--  4X CD-ROM (12X recommended if using Data Disc

as data source).
--  32 MB of RAM and a hard drive with at least 250

MB of available disk space.  For best performance of
“talking maps” and GPS track files, we recommend 64 MB RAM.

--  A Serial, USB, Compact Flash or Bluetooth connection (depending on receiver type).
--  A Soundblaster compatible sound card and speaker for “talking maps”  

For best results, a CD cassette adapter which broadcasts sound into your car 
stereo speakers is recommended.

--  CoPilot's voice recognition requires a microphone and a low-noise 
environment.  For best results, an external microphone is recommended 
(plug in before starting CoPilot).

--  Minimum 800 x 600 resolution.
-- If you are using a third-party GPS receiver rather than ALK's CoPilot receiver, it

must be NMEA 0183 v.2.0 protocol.

Package Contents
--  Install / Data Discs
--  Printed Quick Start Guide
--  GPS receiver and suction cup for securing receiver to windshield (not in 

software-only packages)
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How Reliable is CoPilot?
The CoPilot map database is remarkably accurate, providing comprehensive, detailed street
information.  From the most populated cities to the smallest hamlets, CoPilot map data has been
created to support your travels wherever they may take you.  For more information about GPS
accuracy, see About GPS Technology, p. 15-16.  

Data Quality
Due to the complexity and constantly changing face of road systems in North America,
Europe, and Australia, you may encounter roads that have not been updated in the CoPilot
map database.  That said, the CoPilot map database boasts the following statistics:

Data Corrections
ALK continually updates the CoPilot map database as we strive to provide you with the
highest quality product.  If you encounter missing or inaccurate map data, please contact us
and let us know so that we can include it in our updates.*

* Australian and European users please see Technical Support contact information, p. 77.

** Or choose E-mail Data Corrections from the CoPilot Help menu in Planning Mode 
(North America only)
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ALK Technologies
Attn: Data Corrections

1000 Herrontown Rd. · Princeton, NJ  08540 · U.S.A.
Fax: 609-252-8166 (North America only)

E-mail: data@alk.com ** (North America only)
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About GPS Technology
The Global Positioning System (GPS) is a tracking and navigation system developed by the
U.S. Department of Defense.  The system uses 24 satellites that orbit the earth, sending out
radio waves that can be picked up by GPS sensors (hardware devices for receiving data).
Normally, a GPS sensor relies on receiving signals from four satellites simultaneously to
track its position.  Each signal contains an identifier for the satellite that emitted it and the
exact time it was emitted (to the nanosecond).  GPS relies on the fact that radio waves travel
at the speed of light to calculate distances and the exact location of the sensor is figured by
combining the data received from three or four satellites.

Given the right conditions, a GPS sensor can identify your geographic position anywhere in
the world.  GPS is able to give you the latitude, longitude and elevation of your present
location, as well as your road speed and direction of travel on a route.  

GPS Accuracy
The GPS signal CoPilot receives from the constellation of satellites has a rated accuracy of
10 meters.  This means that 95% of the time the reported location is within 10 meters (30
feet) of your exact position.  CoPilot takes this location information and enhances it further
by "snapping" it to our street and highway network.  Occasionally, CoPilot will place you on
the wrong road.  If this occurs, keep driving and CoPilot will automatically correct itself and
find your proper position.

At times, CoPilot's GPS tracking will be less accurate or fail to work at all because the unit
is unable to receive satellite signals.  However, the unit is resilient; eventually, it finds itself.
Its ability to report your location is directly proportional to its ability to receive accurate
line-of-sight satellite signals.  Heavy foliage, buildings, tunnels, or any other structures
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WARNING:
CoPilot navigation instructions are only computer-generated advisories
and may contain errors.  Obey all traffic regulations even if they are
completely contradictory to the navigation suggestions.  Keep your eyes
on the road and hands on the wheel! Do not attempt to look at the
screen if you are the driver.  ALK® assumes no responsibility for any
damage or injury resulting from the use of this product. 



obstructing satellite communications will interfere with CoPilot's ability to track your
location. Like your car radio, GPS tracking can also be affected by weather conditions if
severe.  CoPilot will continue tracking as soon as adequate signals are available.  

NOTE: The GPS unit should be placed far forward on the dashboard to maximize the
satellite reception area.

How CoPilot Uses GPS
CoPilot uses the GPS positional data it receives from the GPS receiver to display your
current position and route on a map as you drive.  This is called “tracking.”  CoPilot also
uses the GPS data it receives to “navigate,” that is, to guide you along your planned route,
provided you enter a destination.  

If you enter a destination you will be given navigation instructions, and your route will be
tracked on the map.  If you do not enter a destination, your route will be tracked as you
drive, but you will not be given directions as CoPilot has no way of knowing your
destination.

A Safety Warning
Do not use this product in any way that interferes with safe and attentive operation of a
vehicle.  When used in a vehicle, do not place the GPS receiver, antenna, power supply, or
your computer where it may strike the driver or passengers if the vehicle turns sharply or
stops abruptly.  This product is designed, manufactured, and intended as an aid to planning,
tracking, and following routes in privately owned vehicles.  

The accuracy of the map data, driving directions, and GPS tracking system is insufficient for
this product to be used for automated navigation or in any situation in which the failure of
the product could lead directly to death, personal injury, or physical or environmental
damage.  The driver must remain alert at all times to actual road conditions and obey all
posted signs and traffic regulations.  ALK Technologies and its suppliers specifically
disclaim any express or implied warranty of fitness of this product for automated navigation
or for aiding in the operation of other than a privately owned vehicle.
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Installation
NOTE: If you are updating from an older version of CoPilot®, you may want to uninstall
the older version first (see Uninstalling, p. 20-21).  This is not required, however.  CoPilot
Live | Laptop 7 can be installed while another version of CoPilot remains on your computer. 

1. To install CoPilot, first turn on your computer (and the external CD-ROM drive if
necessary).  Have your Product Key Code ready (this code can be found on the front of
the printed Quick Start that came with your product). Do not lose this Key Code, you
will need it for installation and registration.

4. Follow the instructions, clicking Next to go from one screen to the next in the
Installation Wizard. As the installation proceeds, you will be given the choice to install
CoPilot map data. It is recommended that you install the Map Data to your hard
drive.  A full installation of the data can require up to 1 GB of available space depending
on which region you’re installing.  If space is unavailable, you can run the program by
inserting the Data Disc into your CD-ROM drive after you open the CoPilot application.
NOTE: Once a region is installed it cannot be changed.   

3. After clicking Yes to accept the License
Agreement, enter your Product Key Code
(see Step 1) when prompted, then click
Next.

2. Insert the CoPilot Install Disc into your
CD-ROM drive.  The installation will start
automatically within a few seconds.



5.  At the end of the installation process you will be prompted to activate the software.
CoPilot must be activated in order for you to use it.  Follow the instructions.  For more
details about activation, see the Software Activation section below.

6. Plug the GPS receiver into your laptop.  See Hardware Setup, p. 21-23.  
NOTE: The receiver must be attached before you can use CoPilot for guidance.

7. Make sure the date and time are set correctly on your computer.  This is extremely
important for CoPilot Truck to function properly.  To check and/or change the date and
time, go to the Windows Start button, Settings, Control Panel, Date/Time.

To start CoPilot, double-click on the CoPilot Live | Laptop 7 icon that was created on your
laptop when you installed the program.  To quit at any time, select Exit from the File menu
in Planning Mode, or Exit in the Guidance Mode navigation control panel.  

NOTE for XP Users:  If you are installing CoPilot on a computer running Windows XP,
you may be prompted to connect your GPS receiver during installation.  If you are using the
USB GPS receiver, Windows XP will pop up a message warning you about Windows Logo
testing.  Click Continue Anyway if this warning appears.

Software Activation
At the end of CoPilot’s installation process, you will be prompted to activate the software.
CoPilot must be activated before you can use it.  Follow the steps below to activate your
software:
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1. At the end of the software installation,
the License Activation Wizard will
appear.  If you cancel this screen, it
will appear again the first time you
open CoPilot.  For automatic
activation, follow the on-screen
instructions and click Next.



To Activate Manually:
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2. In the next screen, enter your e-mail address and
click Next.  CoPilot will be activated within
seconds provided you established a connection to
the internet in Step 1.  You will see the message
“License activated successfully” when the
process is finished. Click Finish to begin using
CoPilot.

1. Check Activate Manually in Step 1 above, then click Next.  

2. The next screen is the Activation Code screen, where you’ll see your Product 
Key and License ID.  You’ll need this information to manually activate CoPilot 
as follows:

a)  If your laptop is connected to the internet you can click the link to ALK’s activation
web page.

i) On the ALK activation page, enter your Product Key, License ID, and 
e-mail address, then click Submit.  Your Activation Code will appear on-screen
and an e-mail that contains your Activation Code will be sent to you.

ii) Enter your Activation Code in the blank field in the Activation Code 
screen and click Activate.

b)  If your laptop isn’t connected to the internet you can visit ALK’s activation web page
(http://activate.alk.com) on another personal computer.  Follow steps i) and ii)
above.

c)  If you do not have internet access you can call, fax, or e-mail ALK.  Technical
support is available to registered users from 9:00am-5:00pm Mon.-Fri.   

For ALK Technologies contact information, see Technical Support, p. 77.  
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Uninstalling
The following steps outline the procedure for uninstalling CoPilot® 2003 and older versions
of CoPilot: 

To uninstall the CoPilot software:
1. Exit out of any programs that are running.
2. On your desktop, double-click on My Computer.
3. Double-click on Control Panel.
4. Double-click on Add/Remove Programs.
5. Scroll down the list of applications until you see CoPilot [Version].  Click on it to

highlight it, then click on the Add/Remove button.  You will then be asked “Are 
you sure you want to completely remove the selected application and all of its
components?” Click Yes.  This will start the uninstall process.  If prompted to
remove all shared files select No to All.

6. When this is finished, click on Finish.  Then restart your computer.

Deactivation and License Update:
If you’re planning to uninstall CoPilot from one computer and install the same version on
another computer, you need to deactivate the software on the first computer before installing
it again.  To do this, open CoPilot and choose Update License from the File menu.  Then
click Deactivate in the License Manager.  When you re-install CoPilot on another computer,
you will be asked to activate it again.
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To Uninstall Data From Previous Versions of CoPilot:
NOTE:  Data is automatically removed as part of the CoPilot 2002 or 2003 uninstall.  

For earlier versions of CoPilot, this process is not required but you may want to do
this if you have uninstalled the application.

1. Exit out of any other programs that are running.
2. On your desktop, double-click on My Computer.
3. Double-click on Control Panel.
4. Double-click on Add/Remove Programs.
5. Scroll down the list of applications until you see CoPilot 2001 Data CD or Data 

CD setup for CoPilot 2000.  Click on it to highlight it, then click on the 
Add/Remove button.  You will then be asked “Are you sure you want to 
completely remove the selected application and all of its components?”  Click 
Yes.  This will start the uninstall process.  If prompted to remove all shared files 
select No to All.

6. When this is finished, click on Finish.  Then restart your computer.

Hardware Setup
WARNING: Never leave your GPS receiver in a closed vehicle that exceeds 140o F.

Excessive heat may damage it.

See page 22 for a diagram detailing how to set up a USB receiver.  See page 23 for a
diagram detailing how to set up a Serial receiver.  (Although these instructions are specific
to CoPilot receivers, connecting third-party receivers should be very similar.  The GPS unit
should be placed far forward on the dashboard of your vehicle to maximize the satellite
reception area.

The first time you use your GPS receiver it can take up to 15 minutes to acquire a satellite
fix.  After you use it once, the receiver should initialize within a few minutes.  

The GPS receiver works like a radio antenna, so place it at least two feet away from
possible sources of interference (for instance, a cellular phone antenna).



USB Connection
If you are using a USB connection you will have one wire which attaches the GPS receiver
to the laptop through its USB port.  Plug the receiver into the laptop after Windows is
finished booting up.

Windows XP Users: When you first connect your USB receiver, you might see a Windows
message indicating that the drivers have not passed Windows Logo testing (or a similar
warning).   Ignore this message and click Continue Anyway if it appears.
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Serial Connection
When connecting to a laptop through a serial port the receiver is powered through the
laptop’s battery.  Plug the PS/2 port connector on your GPS unit into the PS/2 port of your
laptop.  Do not plug the serial port connector into your laptop until after Windows has
finished booting up.  

TIP: To see the serial ports available on your PC, open the Control Panel, select System,
click on the Device Manager tab, then click on the plus sign next to Ports in the list of
devices.  The Settings box displays the hardware settings used by the COM port.  The
setting for your COM port should be 4800,8,N,1.  See diagram below for connection
instructions.
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CoPilot can be used for in-vehicle navigation (Guidance Mode), trip planning (Planning
Mode), and Live messaging/real-time tracking (from within Planning Mode). 

If you launch the CoPilot application without first attaching your GPS receiver, a screen
will appear (shown below) that lets you choose either Planning or Guidance Mode.  Click
Planning or Guidance to continue.  If your GPS receiver is attached, you will be taken
directly into Guidance Mode.

Guidance Mode is for in-vehicle navigation.
For this mode to function you need to have
your GPS receiver attached to your laptop and
you must be receiving signals.  CoPilot will
guide you to your destination and any stops
along the way using voice prompts and simple
on-screen instructions, and track your position
in real-time on a map.

Planning Mode is for trip planning.  You do
not need to have your GPS receiver attached 
in order to utilize Planning Mode.  In this
mode you can plan trips, print directions and
maps, search for points of interest, add places

to your database, set road preferences, and change system settings and trip options.
Additionally, CoPilot’s Live messaging and real-time tracking capabilities can be accessed
from within Planning Mode.

Live Mode enables you to communicate with a driver who is operating CoPilot and see his
or her position tracked in real-time on the map.  Or, you can use the Live Web page on the
internet (see p. 61).

First View of CoPilot 
Without GPS Receiver Attached

CoPilot Live Overview

TIP:  CoPilot defaults to hiding the Windows Taskbar when in Guidance Mode.  To
change this, switch to Planning Mode and go to Tools > Options > Guidance and place
a checkmark next to Show Windows Taskbar.
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Live Mode

Guidance Mode 
(Passenger screen)

Planning Mode

To move from Guidance Mode to Planning
Mode at any time, click the Planning button in
the control panel on the right side of the screen.  

To move from Planning Mode to Guidance
Mode at any time, click the Guidance button
on the left side of the screen.

To access CoPilot’s Live messaging and real-
time tracking, click the Live button on the left
side of the screen in Planning Mode.

Moving Between Modes
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Guidance Mode

Passenger vs. Driver Safety Screen 
In Guidance Mode, CoPilot provides two different display formats for maps and on-screen
directions that change as you drive.  You can switch between the Passenger screen and the
Driver Safety screen by clicking the Driver/Passenger button at the top of the Navigation
Control Panel (see p. 29).  

In the Passenger screen, your map will always be shown.  In the Driver Safety screen,
your map will not be shown when you drive at more than 10 m.p.h.; however, you will still
receive verbal instructions as well as simple printed directions on-screen.  NOTE: When
driving in Australia, all screen buttons are disabled in the Driver Safety screen. 

IMPORTANT: The driver should pull over to the side of the road when looking at the map
and/or the Navigation Control Panel.  Even if a passenger operates the computer, for safety
reasons, the driver should never look at the computer screen while driving.

Passenger Screen Driver Safety Screen

Click here to
change screens
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Start Driving!
If your GPS receiver is attached you're ready to start driving!  The CoPilot navigation system
will guide you to the destination(s) you enter and recalculate your route should you miss a
turn.

Because CoPilot needs to know where you're going in order to give you navigation advice,
you must enter a destination.  (You don’t need to enter an origin, if the GPS receiver is
picking up signals, CoPilot will automatically identify the start place.)  After you enter a
destination in Guidance Mode, the Passenger screen will open (see p. 26) and a highlighted
route will appear on the map that starts at your current position and ends at your next stop.
Your route will also be tracked on the map as you drive.  NOTE: If your screen is set to
Driver at the top of the control panel, the Driver Safety screen will appear at more than 10
m.p.h., but CoPilot voice technology will remain active and you'll receive simple turn
instructions on the screen. 

If you deviate far enough from your pre-planned route (you might make a wrong turn or
choose to follow your own variation of the route), CoPilot’s “Dynamic Directions” will
automatically recalculate a new path to your destination from your current position. 

To Begin Navigating With Dynamic Directions:

1. Enter a destination, with or without a street address: click Destination, then in the
window that opens click Address.  After entering a location, click Add.  (For more on
trip entry, see p. 30-34.)  You can continue to add stops if you like, CoPilot will route you
to each stop, beginning with the one that was entered last.  You'll see your highlighted
route drawn on the map from your current position to the destination you entered.     

2. Start driving! As your GPS unit receives signals, arrows will appear on the map 
beginning at your start place and track you as you drive.  CoPilot will automatically 
prompt you and tell you when your next turn is coming up.  If you go off route, CoPilot's
“Dynamic Directions” will reroute you to the next stop from your current position.

CoPilot also incorporates Side-of-Street Address Detail to let you know what side of the
street your destination is on.  And, while driving on major highways, CoPilot will give you a
Lane Change Warning if your next turn is a left exit off the highway.
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Using the Navigation Control Panel

BUTTON FUNCTION

Driver/Passenger Toggles between Driver Safety and Passenger guidance screens.
Destination Opens a window that lets you add a destination or edit your 

existing destination(s), or delete all destinations to start over.
Itinerary Displays the directions to your next stop.
Detour In case of traffic delays, enables you to run an alternate route.
Save Current Saves your current location as a Favorite or Custom Place.
Live Lets you change Live messaging options.
Options Lets you view GPS status and modify routing and guidance 

preferences, voice options, and map orientation.
Planning Switches to Planning Mode.
Exit Exits CoPilot.

Guidance Mode (Passenger Screen)

Navigation
Control Panel

Zoom Buttons

Message Alert
(see p. 70)

POIs Show/Hide
Listening
On/OffMap Mode

Buttons

Next Stop Information
(Estimated Time of

Arrival, Distance to go,
and Name/Address)

Speaking
On/Off

GPS Status
Indicators

Customizable
Display Lines

(see p. 39)

Compass

Your Current
Location

Next Turn



Map Display
On the right side of the map, the Zoom buttons let you zoom your map view in (closer) or
out (farther away).  The Map Mode buttons let you zoom the map display to frame either
the area between your current location and your next turn (Next Turn button), your current
location (Where Am I? button), or the route to your next stop (Going To button).
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Next Turn: This view shows your
upcoming turn and the immediate area
between your current location and the
turn.  The map zooms in automatically
as you approach your turn.

Zoom In or Zoom Out: Use the
zoom buttons to zoom your map view
in (top button) or out (bottom button).

Where Am I: This view shows your
current location along the highlighted
route and the surrounding area.  Zoom
level is tight and does not change.

Going To: This view shows you a map 
of the route ending at your next stop.  
In this example the next stop is far away
and the map is zoomed out to show the
entire  route.   The  maps  progressively
zoom in as you approach your destination.

Next Turn Map Mode

Where Am I? Map Mode

Going To Map Mode

TIP: Double-click the map to zoom in and
center it on the spot you clicked.  See Map
Options, p. 39, for more display options.
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Entering a Destination

When you launch CoPilot for the first time with the GPS receiver attached, you will be
prompted to enter a destination.  Select any one of the destination options, and enter your
destination.  When entering an Address, enter either a postal code or the city name and state
or country abbreviation separated by a comma and space, then hit Enter.  Case is not
important (e.g. “princeton, nj” and “Princeton, NJ” are both valid entries).  For more
specific guidance you can also enter a street address, with or without a building number,
and hit the Enter key on your keyboard (e.g. 158 nassau st <Enter>).

TIP: To enter a crossroad as your destination, use an ampersand (&) in the Address field
between the intersecting roads. Example: “Main & Jefferson” returns an address at that
crossroad.

In subsequent uses, when at least one
location has previously been entered, you
will be prompted to confirm or change your
destination(s).  You can choose to Go! to 
the existing destination(s), Add one or more
additional stops, Edit the existing list of
destinations, or Clear all destinations and
start over (see page 33-34 for more details).

Address EntryDestination Entry Options

Destination Confirmation Options



Selecting Address opens a window in which you can 
enter a city name and state/country abbreviation or a 
postal code, and (optionally) a street address. 

The first time you select the Home or Work buttons 
you will be prompted with an address entry window in 
which you can enter your home or work address.  In 
subsequent selections, choosing these buttons will 
automatically enter your home or work address as your 
destination.  

NOTE: To edit your Home or Work address, switch to 
Planning Mode and use the Favorites tab in the Trip 
Planner window (see p. 45 and 47).

Any time you add an address to your itinerary it will 
automatically be added to a list of Favorites.  The 
maximum number of Favorites that will be stored is 25.  
To access this list click on the Favorite button.  You then
have the option of adding a stop to your itinerary, 
deleting it from the saved list, or returning to the 
previous window.  If you exceed 25 favorites, the new 
Favorite will replace the oldest one (the one that has not 
been accessed for the longest amount of time).

In Planning Mode you have the option of pre-planning 
trips and saving them to your hard drive.  In Guidance 
Mode, choosing the Saved Trip option when you are 
adding a stop will give you access to the list of your 
previously saved trips, allowing you to enter a whole trip
rather than individual stops.  The trip can then be edited 
in Guidance Mode if necessary.
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TIP: Whether you use a City/State or the Smart POI search option, the other fields used to
perform a POI search are optional.  To decrease the number of POIs that are returned, do one
or all of the following: select a POI Category, select an of Type option, or enter the first few
letters of a POI.

NOTE: During the initial installation of the software you have to choose between installing
the Typical or Compact POI set.  The Typical set gives you more POIs to choose from.  In
order to go back and change this option at a later time, click on Start > Settings > Control
Panel and double-click Add/Remove Programs.  Select CoPilot Live from the list and click
on Change/Remove > Modify.  Select the POI set you want and deselect the other one.

You also have the option of entering places by using 
the Lat/Long button.  You will be prompted to enter
coordinates in the appropriate boxes.  These coordinates
are shown in the status bar at the bottom of the map in
Planning Mode – so if you were to find a place on the
map and not have an exact address for it, you could make
note of the Long/Lat coordinates and enter them in this
box.

When you select the Point of Interest button you will 
be prompted with a search window.  In the City/State
or City/Country box you will see the city in which you 
have most recently been navigating.  If you want to find
POIs in a different location, simply edit your city entry.
You can also use a “Smart POI” search during a trip.  

If you select Near my current route, the POI search will
find matches close to your current route.  NOTE:  This
option is only available when you are navigating along 
a route.
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Trip Confirmation

The Trip Confirmation window appears every
time you enter a new stop in an active trip.
You can enter as many as 50 stops in any
given trip.  The screen will display your next
few stops, and your final destination.  

In this screen you also have the option of
selecting Go! to go immediately into the
Passenger screen and start navigating, Add
to add stops to your trip, Edit to change the
order the stop order or remove stops, and
Clear to delete all stops.

NOTE: If you are making a quick stop, there is no need to exit the application.
Simply close the lid on your laptop and the operating system will enter Suspend
mode.  When you return to your vehicle, simply open the lid and press any button
and the operating system will resume.

You can access your Microsoft® Outlook Contacts database
by clicking on the Contact button.  

Narrow down your contact search by typing in the first few
letters of the contact’s first or last name and hit the
<Enter> or <Space> key on your keyboard.  Select the
contact from the list and preview the Business, Home, or
Other address by selecting the corresponding radio button.  

Click on the Add button and CoPilot will search for that
contact’s address.  If an exact match is found, CoPilot will
automatically update your itinerary.  If an exact match is
not found, CoPilot will display a list of possible address
matches to choose from.
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Editing Stops

To edit your existing stops, click Destination in the navigation control panel, then click
Edit to bring up the Edit Your Stops window shown above.  From this window you can do
any of the following:

--  Manually change the order of your stops.  Highlight a stop, then click the Move Up or
Move Down button.

--  Delete a stop. Highlighting it on the list and click the Delete button.
--  Change a stop to a waypoint, or vice versa (Toggle Stop).  Waypoints can be used to

guide your route, but CoPilot does not treat them like stops.  The ETA and distance to
next stop shown in Guidance mode do not consider waypoints as stops, though
waypoints do appear in the Itinerary.  

--  Optimize your stops for the most efficient route.  If there are three or more stops on
your itinerary, just click Optimize.  NOTE: To keep your final destination fixed in a
trip that has four or more stops, in Planning Mode select Options in the Tools menu,
then in the General tab check this feature under “Optimize”.  The origin always stays
the same.

--  Click Close to return to the Trip Confirmation window where you can select Go!
(Guidance), Add (add a stop), Edit (edit another stop) or Clear (delete all stops).
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Detour

In Guidance Mode, clicking the Detour button will cause CoPilot to generate an alternate
route around the next few miles of your trip.  This is useful when you need to get around
traffic jams, roadwork, or other unexpected traffic slow-downs but don’t know whether or
not you’ll save any time by turning off your current route.  The Detour button toggles to
Cancel Detour after an alternate route is calculated, so that you can return to the original
route at any time if you choose. 

Detour functionality is available in both the Passenger screen and the Driver Safety screen.

Save Current Location

When you have a GPS fix in Guidance Mode,
you can press the Save Current button in the
control panel to save your current location.

CoPilot will ask you to give the location a
name and will add it as either a Favorite or a
Custom Place.
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Using the Itinerary for Selective Routing

CoPilot enables you to be selective about the roads you take on your trip.  From the
Passenger screen you can customize your Itinerary so that entire segments of a trip can be
avoided if you don’t want to travel along the roads CoPilot has you taking.  (Note that you
can also use waypoints to guide a route along roads of your choosing, see p. 34.)

To avoid specific road segments, in the Passenger screen click the Itinerary button to bring
up your turn-by-turn driving directions.

In the Itinerary screen, highlight the road you want to avoid, then press the F1 key on your
keyboard or click the Avoid Rd. button to avoid the highlighted road.  You can return to
your original route at any time during the trip by pressing F2 or clicking Original Rt. (this
button appears when you choose to avoid a road segment).
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Options

GPS Status

Click the Options button in Guidance Mode to
open a window that enables you to view your
GPS status and change the settings that control
map orientation, voice options, and routing and
guidance preferences.

NOTE: Map and routing options that are set in
Guidance Mode carry over to Planning Mode
and the reverse is also true.

In the Options window, the GPS Status button
opens a dialog box that allows you to view and
change advanced GPS settings.

From here you can change the COM Port and
Baud settings for your receiver, or click Find
GPS to automatically adjust these settings. 
Reset GPS lets you enter a city, state from where
CoPilot can search for satellites.  Typically this
search is based off your last location, but Reset
can speed up acquisition if you’ve traveled a 
long distance without using CoPilot (for example,
if you’ve flown on a plane from New York to Los
Angeles).
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POI Alerts

As you drive, CoPilot can alert you with a voice
prompt and a message window on your screen each
time you approach a Point of Interest.  To turn this
feature on, click the POI Alerts button, then in the
Select POIs to be reported scroll list check all
categories of POIs you want to know about.  For
example, you might only want to know about
restaurants, gas stations, and nature attractions.  

Use the Search __ miles ahead pick list to indicate
how far up the road you want each POI to be when
an alert is triggered.  Use the sliding bar under
Report POIs which are to indicate whether POIs
trigger an alert only when precisely on your route,
or if those close to your route will also be reported.  

The Hide windows after pick list lets you select
how long you want each POI alert to remain on
your screen.

In the alert window, you can click the forward
arrow to scroll through nearby POIs, click the Add
Stop button to add this POI as a stop, or close the
window.
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Guidance
Guidance options let you control various attributes
of CoPilot’s route guidance.

Display GPS Arrow Trail controls whether the
arrow that trails your position is displayed on the
map as you drive.  Display Small GPS Arrow
controls the size of the tracking arrows on the map.

Use the Turn Instruction Timing sliding bar to
indicate how far away from the next turn you want
to be when CoPilot alerts you to it.  When turn
instructions are spoken is dependent on your speed
and distance to the next turn, so you might want to
adjust this setting to suit your needs.

Under Custom Display, choose the information
you want displayed on your screen as you drive.
The choices are the same for each line: current
road, current city, nearest crossroad, speed, time,
elevation, or lat/long at current position. (Line 3
only appears in the Driver screen.)

Map Options

Click the Map button for map display options.
Heading Up tracks your position on the map
moving upward as you drive, whereas North Up
maintains north at the top of the screen.

With Drag Map selected, you can use the mouse
to drag the map in any direction to a desired
location.  With Box Zoom selected, you draw a
box around an area to zoom to it.

Display POIs and Display Turn Restrictions
control whether POIs and turn restrictions are
displayed on the map.  If your map seems too
cluttered, you may want to turn off these options.



- 40 -

Routing Preferences

To set routing preferences in Guidance Mode, click
Options, then click Routing in the Options menu.
Note that the changes you make here will carry over
to Planning Mode, and vice versa.

Vehicle Type
CoPilot comes with pre-defined routing options that
provide RV-friendly routing (choose RV) or routing
that is calculated specifically for most light vehicles
such as cars, SUVs, and small trucks (choose Auto).
If you choose RV routing, narrow roads, tight turns,
and U-turns will all be minimized to provide you
with the safest and easiest way to drive your RV or
other large vehicle.  RV-friendly DOES NOT factor
in bridge heights and weights, so always take note of
these when driving larger RVs.

Routing Type
CoPilot’s Quickest routing type is based on the most efficient route in terms of road quality,
terrain, and urban/rural road classifications.  CoPilot’s Shortest routing type calculates the
shortest route while maintaining reasonable standards of practicality.

Routing Options
When Avoid Tolls is checked, CoPilot’s route calculations will avoid toll roads where it is
possible to do so while maintaining a reasonably practical and efficient route.  When
International Borders Open is checked, routes may cross international borders to provide
better routing.  If this option is not checked, no borders will be crossed. Check Break Every
to include a break time that shows up in your on-screen itinerary and is added to the
estimated time of arrival (ETA) calculations.
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Commands

CoPilot not only speaks to you to inform you of
upcoming turns, but also responds to a number of
commands you speak out loud. The Commands
button in the Options window opens a list of these
commands (note that this is a scroll list,  not a
pick list).

NOTE:  For CoPilot to listen and respond, the
Listening button must be toggled on in the lower
right corner of the Guidance screen.

Listening On Listening Off

NOTE: Background noise may affect CoPilot’s ability to recognize spoken commands.  
You can use an external microphone with noise-cancellation technology to optimize your
experience with CoPilot’s listening device.

COMMAND RESPONSE

Go to sleep/Wake up Either causes CoPilot to enter Sleep mode, or awaken from it.

Driver Switches to the Driver Safety screen.

Passenger Switches to the Passenger screen.

Destination A window opens that contains CoPilot’s destination entry 
options so that you can add a stop or enter a new destination.

Detour/Cancel Detour CoPilot automatically calculates an alternate route, or returns 
you to the original route after a detour has been generated.

POI Ahead CoPilot tells you what the next POI along your route is.

Mute Turns CoPilot’s spoken instructions off/on.
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Zoom in/Zoom out Each time spoken, the view of the map will zoom in or out 
one level.

More detail/Less detail Each time spoken, the map will show more or less detail.

Pan up/down/left/right Each time spoken, the map view will shift up, down, left or 
right from the currently displayed area.

Next turn CoPilot tells you when and where you will make your next 
turn.

Where am I CoPilot tells you your current location along the route.

Going to CoPilot tells you the name of your next stop (or final 
destination).

How far CoPilot tells you how far to your next stop.

Speed CoPilot tells you the speed at which you are currently traveling.

Heading CoPilot tells you which direction you are heading.

Thank you “You’re welcome!”
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A Sample Trip
Suppose you and a friend want to go to a concert on the campus of Princeton University in
Princeton, New Jersey.  You know the approximate location of your destination, but you're
unfamiliar with the area.  There's no need to worry about the trip: CoPilot will guide you
every step of the way!

First, you enter your destination.  (You won’t need to enter a starting place – if your GPS
receiver is picking up signals, CoPilot already knows where you're starting from.)  In
Guidance Mode, your friend clicks Destination, then Add, then Point of Interest.  She
types “Princeton University” in the POIs that start with box and clicks Find.  In a few
seconds, CoPilot finds “Princeton University” in the database and your friend clicks Select,
then Add, and then Go!

Now you're ready to drive to your destination!  

Once the car is moving, your location shows up as a series of arrows drawn on the map.  A
green-highlighted line from your present location to your destination shows the route for
you to follow.  In addition, CoPilot prompts you before each turn if Speaking is turned on.

CoPilot leads you into Princeton without a problem.  However, as you drive along
Witherspoon Street approaching the center of town, you see a traffic jam caused by an
accident up ahead.  You decide to turn onto Wiggins Street in order to save some time.  

No Problem!  Within seconds, CoPilot tells you that you are no longer on the correct route
and automatically gives you new directions to follow from your new position (illustrated on
the next page).  You still get to the concert on time and enjoy a relaxing trip!
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1.  Driving on Witherspoon Street into Princeton, NJ

3.  CoPilot creates a new route from your
current position

2.  Turning off CoPilot’s route onto Wiggins Street



Planning Mode
After launching CoPilot you can access Planning Mode by clicking the Planning Mode
button from the welcome screen or the Planning button in the Passenger guidance screen.
In Planning Mode you can run trips on your desktop to print and take with you or save for a
later time, search for points of interest, calculate fuel costs, add favorite places, add custom
places, and much more.  For additional information on Planning Mode see CoPilot’s Help
Files (select Help Contents and Search from the Help menu).  

The Trip Planner Window
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To access the Trip Planner window use
either the New Trip button on the tool bar,
or select New Trip from the drop-down
Trip menu.

In the Trip Planner window you’ll enter a
start place, end place, and any stops in
between on your trip.  



Cities and Addresses
To enter a trip, begin by typing the name of the place where your trip will start or a postal
code in the City, State (or City, Country) box (e.g. “princeton, nj” or “paris, fr” or
“08540”), then press the Enter key.  Do not include periods in the state/country abbreviation.
A list of matches to your entry may appear; if so, highlight the one you want on the list and
click Select.  

NEW Feature:  If this is not your first use of CoPilot, you can click on the pick list arrow at
the end of the City/State box to see a list of all locations that have previously been entered
as stops.  Select any location from the list to enter it.

To enter a street address, click in the Address box. (This is not required.  If no street address
is entered, CoPilot will route from a point at the center of the city or town you selected.)
Again, a list of matches to your entry may appear; if so, highlight the one you want on the
list and click Select, or click Map to see it on the map. If you enter a street address you can
also assign a name to the address by typing it into the Name box. 

You can enter a crossroad as a stop by using an ampersand (&).  Example: If you want to go
to the corner of Main Street and Washington Street, type “Main & Washington” in the
Address field.  You might see a list of matches - these are addresses where the streets
intersect.

Click the Add Stop button to put the place you entered in the Trip
Itinerary.  You can then highlight it and click the Zoom To button to
see that place on the map.

HINT: If you need help with the spelling of a city name, type the first few letters (at
least two) plus the state abbreviation and press <Enter>.  Then highlight the place on the
list and click Select.  Spelling help for street names is accessed by entering the first two
or more letters of the street name.  The pick list will take longer to come up when there
are more matches to your entry in the database.

- 46 -



- 47 -

Points of Interest
When you select the Points of Interest tab, it will open with the cursor in the POIs that
start with box.  The only field that is required to perform a POI search is City/State (or
City/Country); all other fields are optional.  Once you have entered a city, you can do one
or more of the following to narrow down your search: select a POI Category, select an of
Type option, or enter the first few letters of the Place name.  You can also change the
distance within which you want to search. 

When you are finished entering in your search information, click the Find button to get a
list of all possible matches within the database.  To select one, highlight it by clicking on it
and choose Select to add the place to your itinerary, Cancel to return to the search, Map to
show the place’s location on a map, or Clear to change your selection.  For information on
changing the POI set, see page 32.

Favorites
To save a place as a favorite you must first add it to your Itinerary using the Cities and
Addresses or Points of Interest tab and then click Add Fav.  When you click on the
Favorites tab you will see a list of your previously saved favorite places.  To add a favorite
place to your trip, highlight it and click Add Stop.  In this tab, you can also specify a Home
and Work address.  To do this, highlight an address on the list of favorites and click the
circle next to Home or Work under the list.  Now your home or work address can be
quickly selected as a destination in Guidance Mode (see page 31).  Remember that while
you can access your Home and Work address from Guidance Mode, they can only be
changed through the Favorites tab in Planning Mode.

Contacts 
You can access your Outlook Contacts database by clicking on the Contacts tab.  Narrow
down your contact search by typing in the first few letters of the contact’s first or last name
and hit the <Enter> or <Space> key.  Select the contact from the list and preview the
Work, Home, or Other address by selecting the corresponding radio button.  Click on the
Add Stop button and CoPilot will search for that contact’s address.  If an exact match is
found, CoPilot will automatically update your itinerary.  If an exact match is not found,
CoPilot will display a list of possible address matches to choose from.
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Itinerary Buttons 
Regardless of the tab you select, the same commands will remain in the bottom of the Trip
Planner window.  To the right of the Itinerary you will see five buttons.  Using the Up/Down
arrows you can alter the order of the stops on your Itinerary.  Using the Zoom button you
can zoom to the selected stop on a map.  The Delete Stop button allows you to remove stops
from your trip.  And the Add Fav button lets you add a stop entered on your Itinerary to
your saved list of favorite places (see above).

Stop Optimization
After you’ve added all your stops to the Trip Itinerary, you can click the Optimize button
and CoPilot will automatically re-order the stops to create the most efficient route.  If you
don’t optimize, your trip will be routed in the order in which the stops appear on the
Itinerary.  To alwayskeep the last stop in your Trip Itinerary as your final destination, see
note on p. 34 re. optimization.

Fuel Cost Calculator
To calculate an estimate of your fuel costs for a trip, select Fuel Cost Calculator from the
Trip menu before you run your route.  Fill in the average cost per gallon of fuel that you
expect to pay, and the average number of miles per gallon you can expect to get in your
vehicle.  Click OK, then run your trip.  A fuel cost will appear along with time and distance
estimates in the trip summary CoPilot creates for every trip.

Fuel Cost Calculator Trip Summary with Fuel Cost



Running the Trip
To see a complete map of your trip, as well as detailed, turn-by-turn driving directions, click
Run.  To generate a round trip, click the Round Trip check box before clicking Run.  A
round trip includes all intermediate stops on the way to your destination, but routes directly
from your destination back to your starting place.

Options, Clear, Help
Click the Options button in the Trip Planner window to change your travel speeds, route
type, and road preferences (see below for more on Trip Options).  The Clear button cancels
the trip you have been planning and allows you to start a new one.  For more information
about the Trip Planner window and trip planning, click the Help button.  

Trip Options

In the Trip Options window you can change
various routing preferences.  The options 
here are the same as the routing options in
Guidance Mode. Note that options set here
affect route calculations in Guidance Mode
and the reverse 
is also true. 

Vehicle Type
CoPilot comes with pre-defined routing options that provide RV-friendly routing (choose
RV) or routing that is calculated specifically for most light vehicles such as cars, SUVs, and
small trucks (choose Auto).  If you choose RV routing, narrow roads, tight turns, and U-
turns will all be minimized to provide you with the safest and easiest way to drive your RV
or other large vehicle.  Note that RV-friendly DOES NOT factor in bridge heights and
weights, so always take note of these when driving larger RVs.
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Routing Type
CoPilot’s Quickest routing type is based on the most efficient route in terms of road quality,
terrain, and urban/rural road classifications.  CoPilot’s Shortest routing type calculates the
shortest route while maintaining reasonable standards of practicality.

Routing Options
When Avoid Tolls is checked, CoPilot’s route calculations will avoid toll roads where it is
possible to do so while maintaining a reasonably practical and efficient route.  When
International Borders Open is checked, routes may cross international borders to provide
better routing.  If this option is not checked, no borders will be crossed. Check Break Every
to include a break time in your driving directions and ETA calculations.

Advanced Options

Click the Advanced button in the Trip Options
window to adjust road speeds and preferences.  Use
the sliding bars to favor or avoid each CoPilot road
type.  Average road speeds can be typed in for each
road type or selected from the pick lists.  Road
speeds significantly affect how CoPilot calculates
routes, so it is advisable to adjust these and run
routes in an area you know well to see how the
routing changes.
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Printing Your Map or Driving Directions

After you Run a trip, the Trip Summary window will pop up over a split screen displaying
the map of your trip, and detailed driving directions.  Although the Trip Summary cannot be
printed, both the map and the directions can.  Click OK to hide the Summary window.  To
alter the size of either the map window or the directions window, drag the gray bar in the
center in the appropriate direction.  

To activate a window for printing you must click on it (only the active window will be
printed).  To print the active window, click the Print button on the tool bar or select Print
from the File menu. You can also select Print TravPak from the File menu.  This will print a
series of maps for your trip, plus detailed driving directions.
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Beyond the Basics
If you’re familiar with the basic features of CoPilot, you’re probably ready to try some of
the advanced features.  Some of these features are briefly described on the following pages.
For more information on advanced features see the Legend on page 59 of this manual, and
see Trip Planning: Beyond the Basics in the Help Files (under Planning Mode in the
Contents tab). 

Picking Stops from the Map
To pick a stop from the map with the mouse, first zoom into the area from which you want
to select a location.  Then open the Map menu and select Pick Stops from the sub-menu of
Mouse Modes, or click on the Pick Stops button on the tool bar.  With Pick Stops turned
on, click with the left mouse button on the location you want to add to your trip (it can be a
city or any location, including a local address or latitude/longitude point).    

When you pick a stop, the Add to Trip Planner dialog box will appear.  You may add the
location as 1) the start place, 2) a stop, or 3) the end place.  (Note that any previously-
entered start or end place will become a waypoint if a new start or end place is chosen.)  

Now click on OK to close the dialog box,
then select Edit Trip from the tool bar to
bring the Trip Planner window forward.
You'll see that the stop you picked now
appears as either the start or end place, or
an intermediate stop on your Trip Itinerary.  

Click on the Run button to rerun your trip
with the new stop.  You can pick multiple
stops from the map before re-running the
trip if you wish.
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Adding Custom Places
CoPilot gives you the ability to add new places with your own custom names to the map
database.  After adding your custom place to the map database, you'll be able to enter it as a
start place, end place, or waypoint for any trip you run.

To add a new place, click on the Add Custom Places button on the tool bar or select Add
Custom Places from the sub-menu of Mouse Modes in the Map menu.  The map window
should be open and active, and be at a zoom level of 10 or higher (look at the title bar, e.g.
"Detail Level 10 of 12").

Now click on the spot on the map where you want your new place to be added.  The Add
Custom Place dialog box will appear.  

Type your custom name for the place in the PlaceName box.  The name you enter must be
50 characters or less, including spaces, and must start with a letter (not a number or symbol).
You must also enter the address of the custom place.  It does not need to be exact, it is only
used to describe the custom place.  Optionally, enter a phone number and choose which POI
category this place should be included in.  Click Apply to save the place and see it as a
pushpin on the map.

To access this place at a later time, select Manage Custom Places... from the Tools menu
(see Editing Custom Places, p. 56).
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Avoiding and Favoring Roads
CoPilot gives you the ability to avoid or favor specific road segments.  This feature is handy
when you want to avoid a traffic jam or road construction, and can also be used to guide a
trip along a route you know you want to take.

To avoid or favor a road, first click either the Avoid or Favor button on the tool bar, then
click on a road segment on the map.  Zoom your map view in as far as you need to in order
to pick the right segment.  You can pick one or several segments on th same road.  Red
cross-hatching indicates an avoided road segment, green cross-hatching indicates the
segment is favored.  The example below shows an avoided portion of Route 27 outside of
Kingston, New Jersey.

Avoid and favor preferences can be edited in the Custom Roads Manager.  Select Manage
Custom Roads from the Tools menu.  Avoid/favor preferences you set in Planning Mode
will be active in Guidance Mode. 

No Avoid/Favor Modifications Route 27 Will Be Avoided



Importing Custom Places

CoPilot Live’s Custom Place Import Wizard enables you to import addresses from your
Outlook Contacts database, an Excel file, or text file.  (If you are using another type of
database or contact manager, you can export your contacts/locations to an Excel or text file
before importing them into CoPilot Live.)  These points are then added to CoPilot’s POI
database, in a category and type of your choice.  Once in the database, they are displayed on
maps as pushpins and included in search results when you search for points of interest in
either Planning or Guidance Mode.  NOTE: CoPilot now allows importing of multiple POIs
with the same name (e.g. an entire database of “Starbucks”).

To access the Wizard, choose Import Custom Places from the Tools menu in Planning
Mode, then follow the step-by-step instructions given by the Wizard.  Use the Data Import
Status window to edit any addresses that were not accepted during the importing process,
then click Add to import the final list of addresses.

For more detailed instructions, refer to the CoPilot Live Help files on your desktop (Help
Contents and Search in the Help menu).
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Editing Custom Places

After custom places have been added to the database, they can be edited at any time.  Select
Manage Custom Places from the Tools menu, then highlight the custom place you wish to
edit, click Edit, and make your changes.  Click Apply when finished.

NOTE:  By default, addresses entered as Custom Places are assigned to the Custom POI
category.  You can change this assignment at any time by selecting another Category from
the drop-down pick list as you edit.
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Customizing Your Driving Directions Display
CoPilot gives you precise, turn-by-turn driving directions, plus time and distance
calculations for every trip you run between a start place and a destination.  Print these
directions, and/or customize them by editing the font CoPilot uses and by controlling the
number of “nearby places” -- that is, landmarks or places of interest in the area surrounding
your route -- that appear in the report.

To change the appearance of your driving directions, choose Change Fonts from the sub-
menu of Itinerary Fonts in the Edit menu.  This opens a standard Windows dialog box that
allows you to change the size and style of the font in the driving directions as you would in
any Microsoft Word document.
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To control the number and type of landmarks reported, select Landmark Reporting from
the Trip menu to open the Landmark Reporting dialog box.  

NOTE: You can use these options in Planning Mode, but not in Guidance Mode.

Use the slide bar under Find landmarks within this distance of your route to control the
size of the area around your route in which landmarks should be reported.  If you simply
want to exclude all landmarks from your driving directions to avoid clutter, move the slide
to 0 and click OK to close the dialog box.  You can also have landmarks reported only along
certain types of roads.  Under Find landmarks when driving on these kinds of roads, use
the check boxes to include or exclude the listed road types.

To increase or decrease the number of landmarks reported, use the slide bar under Report
this quantity of landmarks in the driving directions.  

TIP: The more places you want reported, the more time it will take to generate the driving
directions and map for your trip.

You can also select which categories of landmarks you want reported.  Place a checkmark
next to each category to be included by clicking in the box next to the category name.
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Legend

Planning Mode Tool Bar Buttons:

Open/Save Trip: Allows
you to save a trip you have
outlined in Planning Mode,
or access a previously saved
trip.

Edit/New Trip: Prompts
the Trip Planner window
where you can enter
addresses, search for points
of interest, and recall
favorites.

Run: After finalizing your
Itinerary the Run button will
calculate your trip and give
you detailed instructions.

Print: Prints the active
screen in Planning Mode.
You can also use the Print
command in the File menu.

Avoid/Favor Road:  Click
one of these buttons, then
click a road segment on the
map to avoid or favor it.

Help: In any window, the
Help button will direct you
to the Help topic that
describes how to use that
window.

Zoom to Entire Region:
Zooms to a map of the entire
region selected in the Map
menu.

Zoom In/Out: Allows you
to zoom in or out for various
views of your map.

More/Less Detail: Allows
you to view the map with
more or less detail.  The
more detail, the longer the
map will take to load.

Toggle Trip Views:  Cycles
the window display from a
split screen (Trip Map and
Itinerary) to map only to
itinerary only (available only
after a trip has been run).

Refresh Map: Immediately
redraws the current map for
you.

Map Features: Prompts a
dialog box where you can
activate or deactivate certain
features on your map.
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Buttons in the Trip Planner Window:

Label Cities and Places:
Allows you to label or
unlabel cities within your
map.

Add Custom Places:
Allows you to label specific
places on the map and save
them in your Points of
Interest database (map detail
level must be at least 7.)

Zoom to Stop: Zooms your
map view to the stop that is
highlighted on the Trip
Itinerary.

Delete Stop:  Removes the
highlighted stop from your
Itinerary.

Clear: Clears all stops
entered in the Trip Planner
window to enable a new trip
to be entered.

Optimize:  Click this button
to reorder the stops in the
Itinerary for the most
efficient route (requires at
least one stop).

Pick Stops: Allows you to
pick stops directly from the
map and add them to your
trip Itinerary.

Label Roads:  Lets you
determine whether individual
roads on the map will be
shown with or without
names.

Scroll Up/Down: Moves the
currently highlighted stop up
or down in the Trip Itinerary.

Add Fav: Adds the
highlighted stop to your list
of favorite places once it has
been entered into the Trip
Itinerary.  

Options: Lets you change
your trip type, travel speed,
and roads which you want to
favor or avoid.

Send: Sends the active trip
via Live messaging.



CoPilot Live Communications
CoPilot Live allows you to maintain two-way communication with drivers who are using
CoPilot and to actually see where they are currently located using your computer with
CoPilot installed or from our CoPilot Live web page.

Using this CoPilot Live functionality requires the following:

1) If you want to track and message other drivers: An Internet connection on the
computer where CoPilot is installed, or access to our CoPilot Live web page
through a normal web browser.

2) If you want others to track and send messages to you in your vehicle: CoPilot
Live running in your vehicle.  You must have a wireless Internet connection.

CoPilot Live Web
As a CoPilot user, you can create an account on our website that allows you to join the
CoPilot Live Network.  Then your family, friends, and coworkers can "see" you and
communicate with you anywhere in the world!  Through the website you can do all of the
following:

1) Send text messages to CoPilot users using large, customizable, one-touch
response buttons to ensure driver safety.

2) Real-time tracking of other people who are on the road.  See their current
location, destination, ETA and much more.

3) Send itinerary updates including new stops and revised destinations, allowing you
to coordinate changes in plans with someone who's on the road right now without
forcing them to pull over and enter new information.

4) Text-to-Speech enhances safety for all your communications: Text messages and
itinerary updates are spoken out loud when you send them, keeping the recipient
focused on the road ahead.

5) Create an online account from where you can send temporary or permanent
tracking numbers to friends and family.  You can also create and join groups with
other CoPilot users and manage all your account preferences.

Since you're the one who owns CoPilot, it's likely that your friends and family will be the
ones logging onto the CoPilot Live web site to communicate with you.  However, setting up
your own account allows you to distribute tracking numbers and have tighter control of the
security so you know who has access to you while you're on the road.  
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For more information and complete details, visit the CoPilot Live Tracking Website at
http://live.alk.com.

On the following pages you'll see how you can communicate with someone on the road
from within CoPilot (the Live Mode sections) and also what it's like to be the driver using
CoPilot when someone else is communicating with you (the Driving with Live sections).

Live Mode - Overview
Although the CoPilot Live web page is the best way to communicate with people who are
on the road, you can also access CoPilot Live's communications capabilities in Live Mode
from within CoPilot.

In Planning Mode click on the Live icon on the sidebar to the left of the map.  The upper
portion of the new pane that opens is the Vehicle List.  Your connection to the CoPilot Live
network will be displayed above the Vehicle List.  Remember that you must have an Internet
connection to get onto the CoPilot Live network.  

The Screen Name of the driver is displayed on the Vehicle List, with columns for the
vehicle's next stop, ETA, speed, location, and time of last update.  To see all columns,
expand the pane by placing the cursor on the right edge until it becomes an arrow and
dragging. 
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Vehicle List

Message
Center



Below the Vehicle List is the Message Center.  The text of sent and received messages will
appear here.  

NOTE: All of CoPilot Live's communications are done in real-time.  This means
information is only transferred when you and the person in his vehicle are using CoPilot
Live at the same time.  In this sense CoPilot Live communication is similar to using a
telephone —  communication only occurs when both parties are on at the same time.  

ALK does not actively log driver's location information, nor do we use this information for
any purpose other than to transfer it between authorized users.

Live Mode - Automatic Vehicle Location (AVL)

When you're in Live Mode you can track the location of a driver.  Double-clicking the
vehicle in the Vehicle List will center the map on the driver's last reported location.  The
vehicle location updates as long as both you and the driver are running CoPilot Live; the
information is updated at an interval specified by the driver (see Driving with Live - Set Up,
p. 68).
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Live Mode - Send/Receive Messages
To send a message to the driver, click the Send Message button on the tool bar or right click
on the vehicle and select Send Message from the pop-up window.

Click just below the Standard Response Buttons, and begin typing.  

The Standard Response Buttons are included in every message and are described in detail 
in Driving with Live - Receiving Messages (p. 70).

You have complete control over the Customizable Response Buttons:

1) Choose to display 1-4 buttons by clicking the corresponding number at the bottom 
of the screen.

2) To change the text of each button, just click on a button and start typing.  The driver
will see whatever text you enter and when the driver responds, the text of the button
he or she selects will be sent back to you.   

Once you have typed your message and specified your Customizable Response Buttons,
click the Send button to send your message to the driver.
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When the driver responds to your message, the response is displayed in the Message Center:

Advanced
Clicking on the Advanced tab of the Send Message window will expand the view.  From
the Advanced view you can save frequently used message text and button layouts that you
can recall for future messages.
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Message and Driver’s Response



Live Mode - Send Itinerary Updates
To send a Trip Itinerary Update to the driver, click the New Trip button on the tool bar,
create a trip itinerary in the Trip Planner window just as you would in Planning Mode, and
click Send.  Or right click on the vehicle and select Send Trip from the pop-up window:

In the Send Trip Confirmation window you can specify whether you want the new trip
itinerary to replace the driver's existing trip, to be added as the next stop(s) in the driver's
current itinerary, or to be added as the last stop(s) in the driver's current itinerary.  Click OK
to send the trip itinerary.  NOTE: CoPilot Live always uses the driver's current location as
the start point for giving route guidance.
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When the driver responds to your trip itinerary update, the response is displayed in the
Message Center:
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Send Trip and Driver’s Response



Driving with Live - Set Up
The previous sections have detailed how you can communicate with someone else who's on
the road from within the CoPilot Live program.  These following sections will describe how
it looks when you're the one on the road.

To enable tracking and messaging, you (the driver) must first create a login account using
the CoPilot Live Web login page. Once you have submitted a User Name and Password on
the web, you then enter the same user name and password — once only — within the
CoPilot application to complete the setup.  NOTE: Traffic is not yet available, the buttons
for traffic are currently disabled.
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1.  Go to the CoPilot Live Web login
page.  Click Create a new account, and
enter all required information including
a User Name and Password.

2.  Open CoPilot.  In Guidance mode,
click the Live button.  Once you are set
up (see steps below), from this window
you’ll be able to turn the connection to
the Live Network on or off, toggle
messaging on or off, and specify how
long Live messages are displayed if no
action is taken to interact with the
messages when they appear. 
NOTE: You can also complete the setup
process in Planning mode — choose
Options from the Tools menu and use
the Live tab.

3. Check Enable Live Network to
enable tracking, click Messenger to
toggle it “On” so messages can be sent
and received, then click Go. 
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4.  In the window that opens, enter a
Screen Name that will identify you to the
person on the other end for messaging and
tracking.  You can also use the Send
position info every _____ pick list to
change the interval at which your vehicle’s
position will be updated as you are
tracked.  Click Go to continue.

5.  The first time you do this, a message
will pop up that informs you about the
CoPilot Live setup process.  After you
have read the message, click OK to
proceed.

6.  Now you must enter the same User
Name and Password that you entered
when you created your account on the Live
Web page.  Click Apply to complete the
driver-side setup process.  

You are now set up for messaging and
tracking. Once you are set up, you’ll only
need to enable the Live Network for
tracking and turn Messaging on (Steps 2
and 3 above).

Your screen name and/or password can be
changed as many times as you like.  Your
password must be changed from the Live
Web page.  Your screen name can be
changed from within CoPilot — click
Settings in the Live Options window.



Driving with Live - Receiving Messages

On the top are the four Standard Response Buttons, which appear on every message: 

Speak Message: CoPilot Live's text-to-speech engine speaks the text of
the message.

Defer Message: Defers the message, which will reappear later.  Useful
when you need to concentrate on the turn instructions
and the road.

More Information: Sends a response back that you need more information.

Delete Message: Deletes the message. Notice of the delete is sent back.

You can also tap one of the Customizable Response Buttons that the message sender has
included at the bottom of the screen.  The text on the button is sent back as the response.
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When you are the driver and a message is
sent to you, CoPilot displays it on top of all
other windows.  CoPilot's text-to-speech
engine will speak the text of the message
out loud when the message is received.  If
you hit the Defer button (see below) or do
not respond within the time limit you have
set, the message will be put in a queue and
the Information button in the lower right
corner of the Guidance screen will turn
from gray to red. You’ll need to click the
Information button to read the message.  If
other messages have been queued behind it,
the messages will appear in the order they
were sent.



Driving with Live - Receive Trip Itinerary Updates

When you are the driver and a Trip Itinerary Update is sent to you, CoPilot Live displays it
on top of all other windows.  CoPilot Live's text-to-speech engine will speak the itinerary
update when it is received. 

The four Standard Response Buttons appear and are described in detail in Driving with Live
- Receiving Messages (p. 70).

You can Accept or Decline the change to your trip itinerary.   If you accept the change
CoPilot Live will automatically start giving route guidance using the new itinerary.
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CoPilot Live Real-time Traffic Reporting
In addition to providing pre-trip planning, GPS route guidance, and Live messaging
capabilities, CoPilot Live uses wireless communications to automatically send real-time
information to drivers, notifying them of traffic incidents along the route ahead and creating
potential alternate routing.

In Guidance Mode, CoPilot Live can provide you with regularly updated traffic incident
reports and alternate routes based on your destination and route ahead.   (Note that in
Guidance Mode, CoPilot must have GPS acquisition, a user-inputted destination, and
Internet access in order to provide real-time traffic information.)

In Planning Mode, CoPilot Live provides regularly updated traffic incident reports and
alternate routes based on the user's origin, destination, and planned route.  This can be
quite useful as it enables you, for example, to review traffic conditions specific to your
planned routes before even entering your vehicle.  (Note that in Planning Mode CoPilot
must have a user-inputted origin, destination, and Internet access in order to provide real-
time traffic information.)  

Live Traffic in Guidance Mode
Begin by launching CoPilot Live on your laptop.  In Guidance mode, click the Live button,
then check Enable Live Network and click the Traffic button to turn traffic reporting on.
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Check Traffic
Click the Check Traffic button to see all traffic incidents on the route ahead between your
current position and your destination.  CoPilot will take a few seconds to check for
incidents.  If any incidents are found, they are reported one by one beginning with the one
closest to you.  You will see them on the map (see p. 75) and can decide whether you want
CoPilot to continue along the current route or to generate an alternate route around the
reported congestion (you’ll be able to accept or reject the alternate route).  

- 73 -

If you want CoPilot to generate an alternate route
around an incident, click the Avoid button. If you
wish to ignore the incident, click one of the two
arrows.  The forward arrow takes you to the next
incident (if there is one) and the back arrow takes
you to the previous incident (if there is one).

If you do not respond to a message, it will be
automatically hidden after the amount of time you
set in the Live Options window (p. 72) — or after
30 seconds by default.  When that happens, CoPilot
will either ignore or route around the incident based
on how you have set your options — see Traffic
Settings, p. 74.



Review and Clear Traffic
The Check Traffic button in the Live Options window brings up only new incidents along
your route that have not been reported yet.  To review the traffic incidents that were already
reported, click the Review Traffic button.  To clear the traffic incident queue so that Check
Traffic brings up every incident, click Clear Traffic.

Traffic Settings
Click Settings in the Traffic section of the Live Options window to set additional options
that tell CoPilot how to handle incident reporting.

The Speak new incidents check box controls whether CoPilot speaks each incident
message out loud when it appears.  Check Automatically check for new incidents if you
want to be notified about congestion without having to manually check it yourself.  Choose
a time interval for automatic reporting from the pick list.

When CoPilot hides an incident alert that did not receive a response, by default that incident
will be ignored.  If you would like CoPilot to automatically generate an alternate route for
each alert you do not respond to, choose Avoid from the Default incident action pick list. 

Click Go to save your settings.
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Map Display of Incidents
Traffic incidents are displayed on CoPilot Live’s maps as numbered, colored triangles.  Any
of the four icons below are used to reflect the location(s) and severity of traffic congestion.

1  (Red) - Most severe 3  (Yellow) - Third most severe

2  (Orange) - Second most severe 4  (Cyan Blue) - Least severe

Severe Incident Ahead

Incident Avoided by Alternate Route



Live Traffic in Planning Mode
In Planning Mode, CoPilot Live provides traffic reporting and alternate routes based on the
origin, destination and planned route you enter in the Trip Planner window.  This allows you
to plan and save trips that avoid heavy congestion.  These trips can then be opened in
Guidance Mode when you get on the road.

With your laptop connected to the Internet, begin by opening CoPilot.  In Planning Mode,
open the Tools menu and select Options, then click the Live tab.  Traffic reporting features
in Planning Mode look very similar to what you see in Guidance Mode, and the feature
functionality is exactly the same.

In the Live tab of the Options dialog check Enable Live Network, then check Enable
Traffic at the bottom.  Adjust the incident message display time if you like by choosing a
different time-out interval from the Hide messages after pick list (see p. 73).  Click the
Settings button at the bottom to change the reporting options (see p. 74).
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The Check Traffic, Review Traffic, and Clear Traffic options in Planning Mode are found
in the Trip menu (see p. 73-74).
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Trouble-shooting
First things to check: Are all cables properly secured?  Do all components have adequate
power?  Does your GPS receiver have a clear view of the sky?  (Buildings, mountains and
heavy foliage may block your satellite reception.)

Why can't I get a satellite fix the first time I use CoPilot?
The first time the GPS receiver is used it can take approximately 15 minutes to acquire a
signal.  This should not be the case with subsequent uses.  

Why does it take so long to find the satellites?

When the GPS unit is first initialized it can take several minutes for the receiver to locate
the satellites in orbit.  Be sure that the GPS receiver has an unobstructed view of the sky.  

What do I do if the computer will not recognize my voice commands?
For CoPilot to listen and respond, the Listening button must be toggled on in the lower
right corner of the Guidance screen.  Background noise may affect CoPilot's ability to
recognize spoken commands.  You can use an external microphone with noise-cancellation
technology to optimize your experience with CoPilot's listening device.

Listening On Listening Off

What do I do if I can’t hear CoPilot speaking?
To hear CoPilot speak to you, the Speaking button must be toggled on in the lower right
corner of the Guidance screen.

Speech On Speech Off

Most laptops come equipped with a sound card and built-in speakers.  You can adjust the
volume output from your laptop by using the Volume Control panel that comes with your
system.  Frequently, however, the small speakers on a laptop won't produce sufficient
volume to be heard in a moving automobile.  To amplify the output, you can plug something
into the speaker jack, such as additional speakers.  Another alternative is to purchase an 
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audio cassette adapter equipped with a cord and jack that you can plug into your laptop's
speaker jack, then put the cassette into your car's stereo cassette player.  This will channel
CoPilot's commands through your car's stereo system if it's set to play audio tapes.  
NOTE: Please don't drive with headphones on because this is unsafe!

When I try to run CoPilot I get a message that says “CoPilot Can't Find the Data
Disc”, and the program won't start. What can I do?

1. Is the Data Disc in the CD-ROM drive? 

A. If yes, see question 2 below. 

B. If no, place the Data Disc in your CD-ROM drive and try using CoPilot again. If 
you are still having trouble once the Data Disc is in your CD-ROM drive, see question
2 below. 

2. Is the underside (the side without artwork) of the Data Disc clean? 

A. If yes, see question 3 below. 

B. If no (you see lint or finger prints), you can clean the CD by using a soft, clean piece
of lint free material slightly moistened with water.  Place the Data Disc in the CD-ROM
drive once it is dry and try using your CoPilot program again. 
If you're still having trouble, see question 3 below.

3.  Is CoPilot looking at the right drive when trying to read the Data Disc?  To check, please
follow the instructions listed below:

A. First, we need to determine the drive letter of your CD-ROM drive.  (If you already
know your drive letter, move to step B on the next page.) 

To do this: 

1. Go to your Start button/Programs/Windows Explorer.  In the upper left hand
corner of your screen, you'll see a white box (it may have a drive displayed in it)
with a black arrow just to the right of the white box. 



2. Click once on the black arrow so that all of your drives are shown.  Your CD-
ROM drive is the one that has the CD-ROM icon next to it.  And next to the
CD-ROM icon, there should be a letter - this is your CD-ROM drive letter. 
Please remember it and move to section B.

B. Next, you need to check that CoPilot is looking to this drive to locate the Data Disc.
In the example below, your CD-ROM is the D drive.  Your drive letter may be different.

To do this: 
1. Go to your Start button/Programs/Windows Explorer and click on the drive

letter which corresponds to your hard drive (usually C). 
2. Within drive C, find the folder Program Files and double-click on it so that 

all of your program folders are listed. 
3. Find the "CoPilot Live" folder and double-click on it. 
4. Find the “Laptop” folder and double-click on it. 
5. Find the folder APP and double-click on it 
6. You'll see a file named "data.cfg" listed among other folders. Double-click on the

data.cfg file--Windows will open a new window and prompt you to select a
program to open the file with. Scroll down the list of programs and select
Notepad.

7. The second line of the file should read: "LRGridDir"="D:\Data". Make sure the
letter between "=" and ":" is your CD-ROM drive letter. If the drive letter is
incorrect, change it to the correct letter. Go to file and click on SAVE AS, and
then click Save, and then click on Yes to save over existing file. 

8. Close Windows Explorer and run CoPilot normally.

CoPilot keeps saying "No GPS signal. Please check the power connections".
What should I do?

This indicates that CoPilot is not getting GPS data from the antenna/receiver either because
the GPS unit is not getting power, or because the GPS data is not getting from the antenna/
receiver into your laptop. 

1. Is the GPS unit getting power?

A. If you are powering the GPS unit through your car's cigarette lighter, you car needs
to be turned on and the adapter needs to fit snugly into the cigarette lighter. 
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B. If you are powering the GPS unit through your laptop's PS/2 port, make sure the
connection is snug and that your laptop's battery has enough power.  If you've checked
the power supply, and it is sufficient, see question 2.

2. Is the GPS unit plugged into the serial or USB port?

A. The serial port is a 9-pin port usually on the back of your laptop.  One end of the
GPS unit cord should have a 9-pin head that should plug easily into your serial port.  If
you've checked the port connection, see question 3. 

3. Are the port settings correct for the Com port? 
Note: CoPilot uses Com 1 as the default Com port. Some computers may have more
than one Com port.  You will need to test each Com port starting with Com 1.

A. Click on the Start button, Settings, Control Panel.
B. Double-click on the System icon. 
C. Click on the Device Manager tab. 
D. Click on the "+" sign next to Ports. 
E. Click on Com 1 so it's highlighted and click on the Properties button below. 
F. Under the General tab in Device Manager make sure it says this device is working
properly under Device Status.  Next, under Device Usage make sure there is no check
mark in the box Disable in this hardware profile.
G. Click on the Port Settings tab. The settings should read as follows

-- Bits Per Second = 4800
-- Data Bits = 8 
-- Parity = None 
-- Stop Bits = 1 
-- Flow Control = Hardware
If the settings are different you need to make the necessary changes, then click
OK and restart your computer.   

4. Are you using the correct Com port for the GPS unit?  
To check which Com port to use with the GPS unit follow the directions below:
A. Go to your Start button/Programs/Accessories/Communications/Hyperterminal
B. Double-click on the file Hyperterm.exe to open the program.
C. Enter a name (any name) and click OK. 



D. Next at the bottom where it says Connect using select direct to Com 1 and click OK.
E. Next in the Com Port Properties window the settings should read: 

-- Bits Per Second = 4800
-- Data Bits = 8
-- Parity = None 
-- Stop Bits = 1 
-- Flow Control = Hardware 
If the settings are different you need to make the necessary changes and then click
OK. If the GPS unit has power and is able to connect, you will see information flowing
across the screen (random letter and numbers).  If you do not see any information
flowing across the screen, go back to step E above and repeat those same steps, trying
other Com ports (2,3,4) until you find the correct one. 

F. Once you have found the right Com port (1,2,3, etc.), please do the following: 
1. Open CoPilot.
2. Go to the GPS menu and click on the Status tab. 
3. Make sure that the Com port number is the same one you found above (1,2,3, etc.)

in the Hyperterminal.  If it is different use the drop down menu to change the Com
port and click the Close button.  Next exit the program to accept the changes. You
should now be able to use CoPilot normally.

4. If you have a Palm Pilot, you need to close Hot Sync. Note: Hot Sync manager may
be in your Start up folder causing the Hot Sync manager to enable each time you
start your computer.  If you do not wish to manually disable the Hot Sync manager
each time you will need to delete it from the Start menu:

a. To disable the Hot Sync manager click on My Computer. 
b. Click on your C: Drive or the drive Windows is installed to. 
c. Click on the Windows folder. 
d. Click on the Start Menu folder. (If no folders appear click on Show Files.) 
e. Click on the Programs folder. 
f. Click on the StartUp folder. 
g. Now highlight the Hot Sync icon and delete it from the StartUp folder. 
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Using the CoPilot Help Files
CoPilot provides extensive built-in Help to guide you through the program as you use it.
Click on the Help button in a window to open a Help topic that describes how to use that
window.  For example, if you’re entering a stop in the Trip Planner window, the Help button
will open the Help files at a topic that describes the Trip Planner window.  From there, you
can navigate through other Help topics, use the Help Index, or do a search using the Search
window.

Another way to access the Help files is through the Help menu.  Contents and Search will
display the main topics available and allow you to enter a search using the Search dialog
box.  How to Use Help provides Microsoft instructions about using Help files.

You also have the option of activating “bubble help” which automatically provides brief
hints as you pass the cursor over certain areas.  In the Tools menu, select Options and check
Show hints in the Interface tab of the Options dialog box.

Technical Support
After registering your software, you're entitled to technical support and discounts on future
updates.  Check out ALK’s web site for technical support documentation and posted answers
to common questions.  If the web site does not provide an answer to your question, technical
support for registered users is available during standard business hours (9:00 am-5:00pm
Monday-Friday).  You should be at your computer and have your Product Key Code
available when you contact us (your Product Key Code can be found on the front cover of
the printed Quick Start that came with the product).  

Please be sure to reach us using the contact information for your region shown below.
We are sorry, but our support staff in ALK’s regional offices cannot respond to requests for
assistance outside the areas they serve. 

North America - Web: www.alk.com, E-mail: cpsupport@alk.com, Fax: 609-252-8166,
Phone: 888-872-8768

Europe - Web: www.alk.eu.com, E-mail: ukcustservice@alk.eu.com, 
Regular Mail: Suite 595, 2 Old Brompton Road, London SW7 3DQ, UK

Australia - (Travroute Australia Pty. Ltd.) Web: www.travroute.com.au, 
E-mail: support@travroute.com.au, Phone: 03-9855-1652




